EndNote X6 for PC

Instructional Services
www.lib.ku.edu/instruction

Abstract: This document provides instructions on using EndNote X6, a bibliographic database and reference management tool for academic research and writing, citing your references in your paper and creating a bibliography with the Endnote citation tools.
# TABLE OF CONTENTS

## BUILDING YOUR PERSONAL RESEARCH LIBRARY

- Objectives ................................................................. 4
- Getting Started .......................................................... 4
  - Installing EndNote .................................................... 4
  - EndNote Setup ......................................................... 5
  - Creating an EndNote Library ....................................... 5
- Working with Output Styles .......................................... 6
  - Downloading an Output Style ...................................... 6
  - Checking or Changing the Output Style ......................... 6
  - Output styles that use journal abbreviations .................. 7
- Adding References to your EndNote Library ..................... 7
  - Setting up EndNote to Search Online ............................ 8
  - Downloading Citations from the KU Quick Search bar .......... 8
  - Downloading Citations from Google Scholar .................... 10
  - Find Full Text ....................................................... 11
  - Manually Adding PDF Files from Databases .................... 12
- Adding a Reference Manually ....................................... 14
- Working with Your References ..................................... 15
  - Searching for References ......................................... 15
  - Viewing and Editing References ................................ 15
  - Hiding Empty Fields ............................................... 15
  - Deleting a Reference ............................................... 15
  - Using Custom Fields ............................................... 16
  - Sorting and Organizing References ............................... 16
  - Creating Groups of References ................................ 16
- Backing up and Sharing Your Library ............................. 18
  - Saving to a Compressed Library File ............................ 18
  - Copying References or Merging Libraries ....................... 18
- Exporting Bibliographies ........................................... 19

## BIBLIOGRAPHIES AND CITE WHILE YOU WRITE

- Working with Citations ............................................... 20
  - Inserting citations ................................................ 20
  - Deleting Citations ................................................. 20
  - Editing In-text Citations ........................................ 21
Building Your Personal Research Library

EndNote is reference management application that academic writers use to streamline and simplify the research and writing process.

This handout is designed to get you started using EndNote; it contains step-by-step instructions on how to perform basic tasks. For more detailed instructions, or instructions on more complex tasks, please refer to the EndNote user guide (available as a PDF file in the folder in which EndNote is installed) and EndNote’s online help system.

Note: Endnote is available free to KU graduate students, faculty, and staff members. See www.technology.ku.edu/software/endnote for download and installation instructions.

Objectives

In this workshop, attendees will get started using EndNote in their research and writing. Specific topics include:

- Create an EndNote Library (a database of references)
- Add references to your EndNote library
- Search and sort references in EndNote
- Attach references to your Endnote Library
- Modify a citation style to fit your specific needs
- Use EndNote’s Cite While You Write tools to insert formatted references and lists of works cited in Microsoft Word documents

Getting Started

The first time you use EndNote, create a new EndNote Library (or .ENL file). This file will contain all the references for your research project. EndNote will create a second item, a folder (.DATA). This folder will hold your library attachments. Compress your library to keep these two items together when you save or move the library!

Installing EndNote

You can access and install EndNote from http://technology.ku.edu/endnote. When you download the file, however, be sure to choose the Save option rather than the Open option.

EndNote will be automatically saved to your Downloads folder. When the download is complete, open your Downloads folder, right-click on the zipped EndNoteX6Win folder and choose Extract All. When the extraction is complete, double-click on the installer program (ENX6Inst) to continue the installation.
EndNote Setup

When you launch EndNote for the first time it will give you an opportunity to set up an EndNote Web account. EndNote Web is a service that allows you to store your library online and access it through a web browser. If you do not have an EndNote Web account at this time, just click Cancel. You should now be ready to create your own EndNote library.

Creating an EndNote Library

1. Start EndNote. You will be prompted to create a new library or open an existing library.
2. Choose Create a new library and click OK.
3. In the Save in dropdown box, navigate to the folder in which you would like to save your new library.
4. In the File Name box, enter the name for your new library, and click the Save button.
5. A new, blank library will be displayed in the main EndNote window, as shown below. Hover your mouse over any of the icons for additional information.

Notice the Style drop-down menu in the EndNote library above. It is extremely important to set this to the citation style you plan to use or that is required by your department, as it will determine the appearance of both the in-text citations as well as the bibliography. If the style you need does not appear in the Style drop-down list or its Select Another Style option (a collection of several hundred other styles accessed through the Style drop-down menu), see below for information on downloading or customizing styles.
Working with Output Styles

Output Styles (or .ENS files) are sets of instructions that tell EndNote how to format the bibliographic entries and citations it creates from references in a library. Several hundred styles are included with EndNote; however, when new versions of the styles you use are released, you will need to download them from the EndNote website.

Select or change output styles from the Style drop-down menu in the EndNote ribbon in Word. EndNote automatically highlights your current style. To change styles, click Select Another Style. EndNote will open a box with many styles to choose from, however, additional styles are available online.

Downloading an Output Style

To download an output style from the web:

1. Many styles are available on EndNote’s web site at http://www.endnote.com/support/enstyles.asp.
2. Follow the on-screen instructions for downloading and installing your style(s).

Checking or Changing the Output Style

To get information on a style,

1. From the EndNote program (and not Word), click the Edit menu, select Output Styles and then click Open Style Manager.
2. The styles that are included in the list available from your Styles drop-down menu appear with check marks.
3. To modify a style, highlight it and then click **Edit** on the bottom right (pictured on next page).

4. Use the menu to the left to make any necessary changes. For example, use the **Sections** option if you need to include a bibliography at the end of each chapter instead at the end of the document.

5. When you are finished, click **File**, then **Save as** and give the new style a name. EndNote will not allow you to overwrite an original style, however, you are allowed to make changes to styles you have created.

**Output styles that use journal abbreviations**

If you are using a style that requires the use of journal abbreviations, you will want to import a Journal Terms list into your library. This will match full journal names with their approved abbreviations. Most journals will be included but you may find a few that are not. You will need to manually add any missing journal abbreviations.

1. From the **Tools** menu in EndNote, select **Open Term Lists** and then **Journals Term List**. (This option will not appear in an empty library.)
2. Delete all existing terms from the list (you can click and drag to highlight all terms, and then click **Delete Term**).
3. Click on the **Lists** tab and highlight the **Journals list**.
4. Click **Import List**.
5. In the File dialog, navigate to the **EndNote X6 /Term Lists** folder. The path to this folder will begin with your **Computer** folder (rather than your **Documents** folder) and progress through **Program Files** → **EndNote X6** → **Term Lists**.
6. Select the list you want to use and click **Open** to import the journal names and abbreviations from the file into the journals term list.

**Adding References to your EndNote Library**

Many of KU’s online databases will allow you to download citations into EndNote, however, although they are usually straightforward to use, many of the databases have slightly different interfaces for exporting programs. Illustrated below are the instructions for downloading citations from the Quick Search bar on the KU Libraries home screen, followed by instructions for downloading citations from Google Scholar. Both of these databases provide a fairly broad search range and the Quick Search bar will also provide access to physical library holdings, such as books or videos. (Google Scholar will only provide access to online resources.)

In the interest of conducting a thorough search, however, you will want to be sure to search the subject-specific databases that cover your discipline too. Detailed, step-by-step instructions for exporting or importing data into EndNote from other databases (such as Academic Search Complete, JSTOR, MLA Bibliography, Wilson Omnifile, Social Work Abstracts and many more) are available online at [www.lib.ku.edu/technology/citing/import](http://www.lib.ku.edu/technology/citing/import). To learn more about which databases might be best for your topic, you may also want to contact one of KU’s subject librarians: [http://www.lib.ku.edu/infogateway/index.cfm?rtype=subject&page=allContacts](http://www.lib.ku.edu/infogateway/index.cfm?rtype=subject&page=allContacts).
Setting up EndNote to Search Online

EndNote offers three modes for searching, illustrated to the right, which include a Permanent Library (globe with books), Temporary Library (books only) and an Online Mode (globe). The modes, and their functions, can be confusing. For online searches, you will want to use the Permanent Library mode, outlined here in red.

Downloading Citations from the KU Quick Search bar

From the KU Libraries home page (www.lib.ku.edu) you will notice two search bars. The one in the upper-right hand corner (outlined in orange) will search pages pertaining to the KU libraries themselves, providing access to information, for example, about free EndNote training classes offered by the libraries, subject librarians, library locations, etc. The Get Started search bar (outlined in red) will search the library catalog and databases for materials.

1. Begin by typing in your search query and clicking Search.

2. You can use the options on the left side of the screen to narrow your search. When you see results you’d like to keep, check the box to the left of the title. Here, I have selected two articles and a book.
3. When you have finished checking the articles for which you plan to download citations, click on e-Shelf at the top right-hand side of the screen.

4. Your items will appear in a shopping cart format. Select the articles you want to export or click the top box to select all.

5. On the right, a drop-down box shows export options, choose Push to RIS (EndNote, Zotero) from this box and click Go. (Do not choose EndNote Web unless you have an EndNote Web account.)

6. Use UTF-8 encoding in the Import to Citation Manager box which will pop up next.

7. In the next box, choose to Open with ResearchSoft Direct Export Software and click OK.
8. Your new citations will appear in the **Imported References** folder in EndNote's Permanent Library mode. The **Imported References** folder offers only a play-by-play update, so you will only see your most recent transaction listed here. Your citations will also appear in the **All References** folder, where they are permanently stored.

9. Because EndNote defaults to alphabetical sorting in the **All References** list, to set it to show your most recent additions, click **Last Updated** twice to toggle your between oldest first and newest first.

**Dowloading Citations from Google Scholar**

A popular search engine for academic research is Google Scholar. Using Google Scholar while logged into the library will help expand the range of your search and will make more electronic texts available to you.

1. First, from the KU Libraries home page ([www.lib.ku.edu](http://www.lib.ku.edu)) click **G** under **Databases A-Z** to then scroll through the Gs to locate and open Google Scholar.
2. Before you begin your search, you will need to set up Google Scholar to export to EndNote. In the upper right corner of the Google Scholar home screen, click Settings.

3. Under Bibliography manager in the Scholar Settings menu, click Show links to import citations into and from the drop-down menu, select EndNote, then click Save.

4. Google Scholar will save these settings for your current computer and internet browser.

5. Now conduct your Google Scholar search as usual.

6. Although some databases allow simultaneous export of multiple references, in Google Scholar, references must be exported one at a time. To export, first choose the article you want, then click Import into EndNote.

7. The reference appears in the Imported References folder of the permanent library (books and globe). Note that it will not appear in either of the other libraries. It has also been added to the All References list.

**Find Full Text**

The next thing to do is to attach the actual articles or documents to their corresponding citations in the EndNote library. The Find Full Text feature will automatically search for and attach these for you but will most likely not find all of the articles in your list, so you will have to manually add those that are not brought in for you, however, completing this step will reduce that workload.

Before you use it the first time, you must configure this tool to make use of the settings and services contracted by the KU Libraries. The image below shows the correct settings for the KU Libraries.

1. Under the Edit tab, select Preferences and click on Find Full Text.

2. OpenURL Path: [http://vv6tt6sy5c.search.serialssolutions.com](http://vv6tt6sy5c.search.serialssolutions.com)

3. Authenticate with URL: http://www2.lib.ku.edu:2048/login?url=

4. Once the setup is complete, use shift+click or control+click to select the articles that need full text.

5. From the top menu, click References, in the pop-up menu, click Find Full Text and then Find Full Text again in the following pop-up. (“Find Full Text” also appears in the menu on the left side of the screen. Here, however, it is a group set heading and not a functional command.)
6. Click OK to the copyright warning.

7. The paperclips that appear along the left column of the EndNote library indicate the articles for which full-text files have been attached.

Once you have set up the pathways in steps 1-3 above, you should not have to set up the authentication again. Next time you want to Find Full Text, begin instead with step 4 above by highlighting the references you want to search for and clicking References then Find Full Text.

**Manually Adding PDF Files from Databases**

The next step is to return to the databases to collect and attach the PDF files that did not come through from using the Find Full Text command.

1. Click back over to your online databases screen (in this case, Google Scholar). In the example below, clicking either **PDF from jstor.org** or **Get at KU** will provide a re-direct to the article.
2. Save the article to your desktop. Here, the article title is copied from the “Get at KU” screen and pasted in as the **File name**. (Hover your mouse near the bottom of the screen if the gray bar with the save option is not immediately visible.)

3. With the article now on the computer’s desktop, simply drag it over to its reference in EndNote. (You may need to minimize some screens to see your article.) Note the addition of the paperclip showing that the attachment is completed.

4. Or, to attach files by browsing your system’s menus, select, then right-click on the reference in the library. From the drop-down menu, choose **File Attachments**, then **Attach File**, then browse through your documents folder as you would for any other attachment.
Adding a Reference Manually

You can also keep different files together with your EndNote research library (interview transcripts or datasets, for example – things you can’t download from the library) by manually adding references.

To enter a new reference into an EndNote Library:

1. Click on the green + icon OR open the References menu and click on New Reference.

2. In the New Reference window, select the appropriate reference type from the drop-down list at the top of the window (Journal Article, Book Section, Book – some of the additional options are shown on the right). Different references types have different available fields, so choose the type first, before you enter any information.

3. Type or paste the information for the reference into the appropriate fields and attach files.

   Note: Add author information last name, comma, first name, with a hard enter between each name. For institutional authors, such as the Department of Education, place a comma at the end of the name to keep EndNote from formatting the name as a person’s name.

4. When you’re finished entering the reference information, click File, then Save and then X out of the smaller window to return to EndNote’s main screen.
**Working with Your References**

**Searching for References**
You can search references from within the library either from the **Quick Search** box at the top of or from the **Advanced Search** options below. To the right of the **Quick Search** box, you can also hide the advanced search options by clicking **Hide Search Panel**.

![Quick Search and Hide Search Panel](image1)

**Viewing and Editing References**

1. The pane on the far right of the EndNote home screen gives a preview of the reference. To open the full reference, double click on it from the list in the middle pane.

2. From here, you can edit any of the fields in the reference simply by clicking on the title of the field. To add research notes as below, for example, simply click in the **Research Notes** field. A cursor will appear below the field name.

3. Note also the attached PDF file. You can double click to open it in a separate window as well.

4. When you are finished, click **File** from the top menu bar, then **Save** your changes.

5. Use the lower of the two Xs to exit.

**Hiding Empty Fields**
Initially, EndNote displays all fields in a reference. Click **Hide Empty Fields** to on the top right of the screen to view only those fields that contain data. This setting is remembered until you click the icon again.

**Deleting a Reference**
From the **All References** folder, highlight the reference then press **Delete** to permanently remove a reference from your library. You can also delete references from your groups in the same way, but a copy of the reference will still be retained in the All References folder.
Using Custom Fields

EndNote includes several data fields useful for reading notes and other kinds of information in the default reference types (such as the Note field). Users can also customize reference types by adding up to six custom fields.

1. To add a custom field to an open reference, click the Edit menu and then click Preferences.
2. In the EndNote Preferences box, click Reference Types then Modify Reference Types.
3. In the Modify Reference Types box, scroll to one of the Custom Fields and type the name of the field you wish to create.
4. To add a custom field to every reference type, enter it for the first reference type then click Apply to All Ref Types.
5. Click OK and then OK again to close the EndNote Preferences box. The custom field will be available for use when you enter or edit individual references, but will only appear on the machine where it was originally added.

Sorting and Organizing References

From the middle pane of EndNote, references can be sorted according to the fields included in the overhead bar:

1. Click on any of the fields to sort by that field and again to reverse the order in which references are listed in the EndNote library.
2. References are arranged in alphabetical order by title as a default for EndNote. Sorting by Last Updated, however, is particularly helpful when you want to see your most recent additions to the library.
3. You can also click on Edit, then Preferences, then Display Fields to change which fields appear in the bar.

Creating Groups of References

EndNote X6 includes options to create groups, custom groups, smart groups and group sets.

- A **Group** is simply a file folder holding a collection of references you’ve chosen. These references are also stored in the All References folder.

- **Smart Groups** are groups made up of search parameters. A Smart Group searches your local EndNote library and collects items that fit a specific search and then stores them as a group.

- A **Group Set** gives a title to a collection of groups, enabling you to store unrelated sub-libraries within the same EndNote library.
To create a Group Set

Although you can move and re-name your group sets, EndNote will only allow you to delete all but the last group set. Something to keep in mind before you begin.

1. From the drop-down Groups menu, choose Create Group Set.
2. Fill in the name of the set and press Enter.
3. Add groups to fill the set. You can add groups to any set by right-clicking on the set name.

To create a group and add references to it:

1. From the references menu, go to the Groups submenu and select Create Group. Type the name of your group and then press Enter or click in the references list area to save the change.
2. Enter a name for your group.
3. Using Shift+Click for adjacent references or Control+Click for non-adjacent references, populate your new group with references from the library listing in the middle pane.

To create a Smart Group

1. Choose Create Smart Group from the Groups drop-down menu
2. Fill in the boxes to define the parameters of your group. In the image below, a Smart Group named “Manuals” is created to contain any files that contain the word “EndNote.”

The five (fake) files above are moved automatically into the Manuals group. They are still also contained within the All References folder, though. Now, any additional files I add that contain the term “EndNote” will automatically be added to the “Manuals” Smart Group.
**Backing up and Sharing Your Library**

There are two types of computer users: those who have lost data and those who are going to lose data. Keep at least two sets of backup files, each at a different location. EndNote recommends that you have sets for alternate days, so if you discover that something went wrong yesterday, you will have the day-before-yesterday’s version.

Make archival sets of the files listed above whenever you finish an important document. **A backup set should include all of the files that are needed to recreate a final formatted paper.** Label the backup files and store them separately from your computer. Burning them to CD/DVD is recommended. That way, if you ever need to recreate the document, you will have all of the necessary files.

**Saving to a Compressed Library File**

You can save your complete library (the filename.enl file as well as its associated .DATA folder and all of its contents) to a single compressed file in order to easily back up your library, copy it to a flash drive or send a copy to a colleague. Your .enl file and your .data folder must be located together in order to create a complete backup of your library. Once complete, you can double-click on the .enlx file to open the library, however, you must be using a computer with EndNote installed.

1. Open the library in EndNote.
2. From the File menu, select **Compressed Library (.enlx)...**
3. Use the file dialog to save to an **EndNote Compressed Library** (filename.enlx).

**Copying References or Merging Libraries**

Although it would be preferable to have one single library with multiple groups rather than several different libraries, you can copy references from one library to another by selecting a reference then clicking Edit  Copy in the original file then Edit  Paste in the new location.

You may want to consider merging libraries instead. Merging libraries is also particularly useful for bringing libraries together during group research projects. To merge EndNote libraries, open the library you want to keep, then

1. From the top File menu, scroll down to Import then across to file.
2. In the Import File box, click Choose to browse for the library which will be added to the current library.
3. For Import Option select EndNote Library
4. Also in the Import File box, use the Duplicates drop-down menu to tell EndNote how to handle duplicate files.
5. Click Import
6. EndNote will finish by letting you know how many files were imported and how many duplicates were discarded.
Exporting Bibliographies
EndNote can make a formatted bibliography directly from references selected from your library. This is handy if you just want to send a list of your sources to someone else or to make a printout of all or selected library contents.

- If any references in the Library window are selected, the EndNote export dialog gives you the option of exporting just those selected references. If you don’t choose the option to “Export Selected References,” then all of the references that are showing in the Library window will be exported.
- To export all of the references in the Library, choose Show All References from the References menu. If any references are selected, be sure to uncheck the “Export Selected References” check box in the export dialog.
- To export a subset of references use the Search References, Hide Selected References, or Show Selected References commands to show the subset of references you want to include.

1. From within the EndNote windows you can select the output style you wish to use to format your bibliography.
2. If you select specific references to export, use the Show Selected command from the References menu to display only those references.
3. Click the File menu, and then click Export.
4. In the Save as dropdown box, type the file name you’d like to give the bibliography
5. In the Where dropdown box browse to where you’d like to save the exported bibliography.
6. In the Save as Type dropdown box, choose the file type you want for the exported bibliography. Choices include: Text, Rich Text (RTF), HTML, and XML. Select Rich Text (RTF) for a standalone bibliography suitable to print.
7. In the Output Style drop down box, if you have not already done so, select the output style you wish to use to format your bibliography.
8. Click Save to export the bibliography.
Bibliographies and Cite While You Write

One very useful feature of EndNote is Cite While You Write (CWYW), which enables you to insert formatted citations and build formatted lists of works cited within your documents with a click of a button. Once EndNote is installed, the CWYW tools appear in a ribbon at the top of the MS Word window, like this:

![EndNote ribbon](image)

Working with Citations

Inserting citations

To use CWYW tools, you must open your Word document, start EndNote and open your EndNote Library (.ENL file).

To insert either single or multiple citations into your Word document,

1. Position your cursor within the document where you intend to place the in-text citation(s). Click on the EndNote tab then click the magnifying glass or Insert Citation.

2. From the drop-down menu, there are two options for inserting in-text citations: Find Citation or Insert Selected Citation(s).
   a) If you are only doing one, Find Citation will be the most expedient. To find a citation, in the search box enter a keyword, title of the article, author name, or year to locate the reference you want to cite in your paper and click the Find button.
   b) Select the reference you want to cite and click the Insert button. This will insert the in-text citation, e.g. (Johnson, 1981), and the full reference at the end of the document.
   c) Note also the drop-down menu available from the Insert button making different options available for the appearance of your in-text citation, such as excluding the author or year.

3. If you are inserting multiple citations, select them first in EndNote by simply clicking the Go to EndNote icon on the toolbar. Highlight the citations you want then, from either EndNote or Word, click the Insert Citations icon.

Note that at the bottom of your document that EndNote has begun a bibliography based on the in-text citations you’ve added. EndNote will update this bibliography as you make changes to your document. At some point, you will want to add a title such as “References” to the bibliography page.

Deleting Citations

To delete one in-text citation, simply highlight it and click Delete. To delete or change multiple in-text citations, see Editing In-text Citations, below.
Editing In-text Citations

1. To edit citations (for example, to add page numbers, remove the author’s name or include prefacing comments like “See also”), click on the in-text citation and click the **Edit & Manage Citation(s)** button from the top ribbon.

2. The EndNote X6 **Edit & Manage Citations** box, offers several options including:
   
a) Use the arrows to the left of the author name to change the order in which the author’s names appear in in-text citations and bibliography. (this requires adjusting the output settings.)

b) In the lower box, add page numbers or a prefix (such as “See also”) or suffix.

c) Click **Edit Reference** then **Remove Citation** to remove a citation or **Insert Citation** to add one or make changes to a reference.

d) Click **Tools** then **Format Bibliography** to make changes to your citation style or bibliography appearance.

e) Click **Tools** and then **Update Citations and Bibliography** to force Word to refresh your citations (sometimes it is slow).

f) Click **Reference** to read more information about a particular citation.
Citing References in Footnotes or Endnotes

Footnoting styles such as MLA and Chicago 16th A will use these instructions. You must first create the footnote or endnote using the tools provided within Word. Once you have created a note in Word, you can cite references in that note just like you cite them in the body of the document.

To cite a reference in a footnote or endnote:

1. Place your cursor at the location in the document where you would like to place the footnote or endnote, then, from the References tab in the Word menu, click Insert Footnote or Insert Endnote.

2. Word will place the superscript footnote or endnote number for you and will drop your cursor to a designated area for the note.

3. From here, progress as usual from the EndNote tab on the Word ribbon.

4. If you do not want the bibliography to include citations which appear in footnotes or endnotes, you will need to edit the output style. From within EndNote (and not Word) complete the following sequence of commands:
   a) From the top menu, click Edit,
   b) select Output Styles,
   c) choose the second option, Edit “your selected style,”
   d) under Footnotes in the menu on the left, click Templates
   e) and uncheck the box that reads, “Include citations in bibliography.”

Note: In some citation styles, such as that of the American Chemical Society (ACS or ACS No Title), EndNote will automatically place the superscript for you when you click Insert Citation. For these styles, skip instructions 1 and 2 above and simply insert your in-text citations as normal.
**Bibliographies**

Cite While You Write always creates the initial bibliography at the end of the Word document as you go. You will need to add the title (such as “References”) to it manually, however. To make changes to your bibliography, click the little triangle at the bottom, right-hand corner of EndNote’s Bibliography tab.

This will open the Format Bibliography box and allow you to make permanent changes to the font, spacing, heading or other characteristics of the bibliography.

**Creating Multiple Bibliographies**

To create more than one bibliography (one at the end of each chapter of a book, for example), use **Edit → Output Styles** from your EndNote main screen. See page 5 for more information on managing output styles.

**Exporting Bibliographies**

You can use EndNote’s export feature to generate a text version bibliography of your library (or selected references from your library) that can be easily e-mailed. EndNote will export from **only** those references listed in the current library window.

9. From within the EndNote library, select the output style you wish to use to format your bibliography.
10. You can use Shift+click or control+click to select specific references.
11. Click the **File** menu, and then click **Export**.

12. In the **Save in** dropdown box, folder, name and file type for the exported bibliography.

13. If you want to send all of the references in the library, uncheck the **Export Selected References** box.

14. In the **Output Style** drop down box, select the output style you wish to use to format your bibliography.

15. Click **Save** to export the bibliography. Now you can e-mail it as you would any other file.

---

**Working in groups**

**Tracking Changes**

Many writers use some sort of “tracking changes” program when working with multiple editors. The easiest and most stable method for combining EndNote and MSWord’s Track Changes is to work with “unformatted” citations within your document by clicking **Convert to Unformatted Citations** from the drop-down **Convert Citations and Bibliography** EndNote menu in Word. EndNote keeps track of citation in your document in one of two ways: as a formatted citation (represented by the gray shading around the citation when you click on it) and as an unformatted citation (represented by the citation information surrounded by brackets {Yu-Mei, 2002 #12}). When you view your citations as unformatted, you will not see your final bibliography. Return to Word and click **Update Citations and Bibliography** to see your bibliography. Do not unformat your document if you do not have the original references in your libraries. Unlike formatted citations, unformatted citations require that you have the corresponding EndNote libraries open in order to format references. Provided you have the correct EndNote library for the paper, you can reformat your paper at any time to see how it looks. Just remember to return it to its original un-formatted condition before sending it out again for editing.
**Emailing a draft**

It is a good idea to un-format your citations before emailing a draft of your paper to another person to edit.

**Using the traveling library**

A traveling library is a mini-EndNote library that contains only the citations you have used in a particular paper. When you send a traveling library with your document you will send your document with **formatted citations**. Because reference data is kept with each formatted citation, you can collaborate with other authors on a paper without each author having the same EndNote library.

The reference data saved with each citation includes all fields except Notes, Abstract, Captions and Figures. The library is saved as a separate .enl file from the document.

From the EndNote tab in your Word document, select **Export to EndNote** then **Export Traveling Library**, then choose a destination for your references.

![Exporting a traveling library](image)

**Your Final Copy**

Before you submit the final version of your paper, you must disconnect the paper from your EndNote library by removing the field codes.

1. Save your final draft. Notice in the picture below that, before converting, the bibliographic entries are shaded in gray, indicating they are linked with EndNote information. Converting them to plain text will remove this linkage and unhook them from the EndNote program as well, and they will then function according to the same rules that govern the rest of your document.

2. To proceed, from the EndNote tab in your Word document, click on the **Convert Citations and Bibliography** list and then select **Convert to Plain Text**.

![Converting to plain text](image)
3. EndNote will give you a warning message that it is about to create a separate copy of your paper. Click OK.

4. In the new version, the gray shading disappears and the unsaved name “Document1” appears at the top. You will want to save both files: the final draft that you created (with field codes) and the second draft (without field codes). Name them so you know which one is which.

What about last minute additions after you have removed your field codes?

When you find that you have last minute edits to make after you have removed your field codes you should make those edits in your draft that still has the field codes in it. (Now, aren’t you glad that you saved it?) Once you make those edits, save it and remove the field codes just as you did before.

Printing a final copy

Provided your citations are formatted, you can print a paper created with EndNote just as you would any word processed document. The field codes will not show up but the citations and bibliography will.
**For More Information**

Here are some additional sources of information about EndNote:

The **EndNote print user’s guide** is a well-written resource that provides a great deal of information for both beginning and advanced users of EndNote.

The **EndNote web site**, [www.endnote.com](http://www.endnote.com), is the place to find updated versions of connection files, import filters, output styles, and the EndNote program itself. Tip sheets, a technical support database, and utility programs for repairing damaged EndNote Libraries and converting from other bibliography management tools to EndNote are also available from the **Support & Services** area of this site.

The **EndNote users email list**, [endnote-interest@isi.searchsoft.com](mailto:endnote-interest@isi.searchsoft.com), is another excellent source of information and problem-solving ideas. To subscribe, follow the instructions at [www.endnote.com/support/en-interest.asp](http://www.endnote.com/support/en-interest.asp).

**Related Training Available from Instructional Services**

All workshops offered by Information Services are free to KU students, staff, faculty, and approved affiliates.

To learn more about or register for workshops, receive automatic announcements of upcoming workshops, and track workshops you’ve registered for and have attended, visit the [www.lib.ku.edu/instruction](http://www.lib.ku.edu/instruction). You can also check our online schedule at [www.lib.ku.edu/instruction/workshops](http://www.lib.ku.edu/instruction/workshops) for a list of class offerings and their availability.

For further workshop related questions, please email [training@ku.edu](mailto:training@ku.edu).

**Setting Up an InterLibrary Loan Account**

Visit [www.lib.ku.edu/retrievalservices/](http://www.lib.ku.edu/retrievalservices/) to get started.

**Getting Additional Help**

Information Services provides consulting and Q&A help in a variety of ways:

785/864-8080

questions@ku.edu
**Definitions**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>CWYW</td>
<td>Cite While You Write. A set of tools included with EndNote that work with Microsoft Word, and allow you to insert properly formatted citations and lists of works cited automatically.</td>
</tr>
<tr>
<td>EndNote Library (.enl)</td>
<td>A database file, containing references that are imported, hand-entered, or downloaded through a direct connection to a data source. An EndNote Library can contain an unlimited number of references, as well as images and other data (images are stored in a separate data file that is created when the library is created). EndNote Libraries have an .ENL file extension.</td>
</tr>
<tr>
<td>Data folder (.data)</td>
<td>This folder is considered part of the library; it includes images, group information and other files necessary for the library.</td>
</tr>
<tr>
<td>Field codes (used for citations and bibliographies)</td>
<td>Endnote inserts a citation in Word by using a field code. A field code is an imbedded command for Word to look back to EndNote for specific information. Field codes are also used when creating form letters or when using formulas in Excel. A field code is denoted by a grey field when you select it. <strong>Convert to Unformatted Citations or Unformat Citations will turn the field codes off and on.</strong></td>
</tr>
<tr>
<td>EndNote Compressed Library (filename.enlx).</td>
<td>A complete EndNote library (the filename.enl file as well as its associated .DATA folder and all of its contents) saved to a single compressed filename.enlx file in order to easily back up the library or send a copy to a colleague. <strong>This file can only be restored by EndNote version 10 or later.</strong></td>
</tr>
<tr>
<td>EndNote Connection (.enz)</td>
<td>A set of instructions used by EndNote to connect directly to a data source. Some connections (those to commercial data sources, for example) require a login; others, such as the connection to the KU Library Catalog (and many other university libraries), do not. EndNote Connections have an .ENZ file extension.</td>
</tr>
<tr>
<td>EndNote Filter (.enf)</td>
<td>A set of instructions used by EndNote to import saved search information from a specific data source (such as the MLA Bibliography on the Silver Platter platform). EndNote Filters have an .ENF file extension.</td>
</tr>
<tr>
<td>EndNote Style (.ens)</td>
<td>A set of instructions used by EndNote to create bibliography entries formatted for a specific style (such as APA or Chicago) or publication (such as the New England Journal of Medicine). EndNote Styles have an .ENS file extension.</td>
</tr>
</tbody>
</table>